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0 About This Manual

This manual describes the installation, programming and commissioning of 
the NZM-XATS-CSOFT software.

The current edition of this manual in other languages can be obtained from 
the Internet:  www.eaton.com/moeller/support.

0.1 Target group
NZM-XATS-C… Automatic Transfer Switch-Controllers must be fitted and 
connected only by qualified electricians or persons familiar with electrical 
installation.

0.2 List of revisions

0.3 Exclusion of liability
In the event of improper use the manufacturer accepts no liability for the 
device’s electrical safety.

The products described in this document are subject to change. The 
descriptions and data in the catalog are therefore not binding.

0.4 Device designation
The following terms are used for the device types if the description applies to 
all these types:

• ATS-C96: NZM-XATS-C96
• ATS-144: NZM-XATS-C144
• ATS-C: NZM-XATS-C96 und NZM-XATS-C144

Edition date Page Key word New Modifi-
cation

Deleted

04/14 6 Installation (Windows 7) ✓

09/11 First edition

http://www.eaton.com/moeller/support


0 About This Manual

0.5 Writing conventions

4 Manual 04/14 MN01219006Z-EN www.eaton.com

0.5 Writing conventions

The symbols used in this manual have the following meanings:

▶ indicates actions to be taken.

For greater clarity, the name of the current chapter is shown in the 1st 
header line and the name of the current section in the 2nd header line.

NOTICE

Warns about the possibility of material damage.


CAUTION

Warns of the possibility of hazardous situations that may 
possibly cause injury.


WARNING

Warns of the possibility of hazardous situations that could result 
in serious injury or even death.


DANGER

Warns of hazardous situations that result in serious injury or 
death.

￫ Draws your attention to interesting tips and supplementary 
information.
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1 General

1.1 Introduction
The NZM-XATS-CSOFT software enables you to control and parameterize 
one or several ATS-C net Automatic Transfer Switch-Controllers if these are 
connected to a PC via an RS232 interface or a serial RS485 bus (only ATS-
C144).

The software can be used for commissioning the control device, 
troubleshooting and continuous monitoring.

A detailed description of the parameters and the possible setting operations 
of the net Automatic Transfer Switch-Controllers is provided in the relevant 
manual provided as a PDF file on the installation CD.

NZM-XATS-C96: MN01219004Z
NZM-XATS-C144: MN01219005Z

The software provides the following functions:

• Graphical display of all ATS-C measurements
• Access to the Setup menus
• Access to the real-time clock (only ATS-C144)
• Access to statistics data (only ATS-C144)
• Saving, loading and printing of parameter settings
• Display of a virtual front panel of an ATS-C with functional buttons 
• Switching between operating modes
• Keypad lock function
• Display of the Event log, showing the most recent 100 events with date 

and time

1.2 Minimum PC requirements
• Windows® 95/98/2000/XP/7 operating system
• Graphic card with 1024x768 resolution or higher
• A free RS232 serial interface (COM) or USB interface
• 64 MB working memory
• Pentium® class processor or higher
• CD-ROM drive for installation
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1.3 Installation (Windows 7)

To install the software, you need a PC with the operating system already 
installed and running and the installation CD. You should also have at least a 
basic knowledge of the PC and be familiar with Windows® operating system 
commands.

Close all running programs.

1. Please insert the CD into the drive.
2. Right-click on the nzmxatscsoft_setup_[…].exe file on your installation 

CD.
3. Click on Properties and then open the Compatibility tab.
4. Enable the two check boxes shown (see screenshot) and confirm by 

clicking OK.

Figure 1: Tab “Compatibiltity”

5. Start the installation process by double-clicking on the 
nzmxatscsoft_setup_[…].exe.

6. If a previous installation is already present on the hard drive, then the 
installation program will automatically start a procedure to remove the 
older revision. After this the installation process will start.

7. In the window that appears, enter the name of the directory in which 
you wish to install the program or confirm the default directory 
proposed.

8. Follow the instructions on screen up to the end of installation.
9. Restart the PC.
10. Once the installation process is complete, right-click on the program‘s 

icon.
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11. Click on Properties and then open the Compatibility tab.
12. Enable the two check boxes shown (see screenshot) and confirm by 

clicking OK.

Figure 2: Tab “Compatibiltity”

1.4 Activation of the PC - ATS-C connection
To operate the remote control program, it is essential that the PC and ATS-C 
can communicate via serial interface. 

The connection can be implemented in different ways, since the ATS-C144 is 
provided with two independent serial interfaces:

1.5 RS232 direct connection or via USB interface
• Connect the ATS-C and PC via a 51C2 cable.
• Can be used for fast connection for commissioning or maintenance.
• Only one device can be connected.

1.6 RS485 connection (only ATS-C144)
▶ Connect the RS-232/RS485 converter to the PC using a 51C4 cable.
▶ Connect all RS485 interfaces in parallel via the twisted pair cable to an 

interface converter, ￫ Figure 3, page 8. Make sure the polarity is 
correct ( A and B terminals). The interface converter must be insulated 
and have an automatic enable line control circuit.
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▶ In case you have connected more than one device, from the front 
keyboard of each device, enter  the Function setup and set one different 
RS485 serial address for each ATS-C, starting from address 01. Make 
sure that the Baud rate and parity settings match the RS485 setting. 

Figure 3: Connection RS485 interface

a NZM-XATS-C96 Number n, maximum 30

b NZM-XATS-C96 Number 1

c Connection cable “Twisted Pair“, max. 1200 m long

d Controlling unit, e.g. computer

1.7 Connection via a modem (only ATS-C 144)
The remote control functionality makes it is also possible to achieve 
connection from a remote location using two modems. Modems can be of a 
standard type or GSM, and can be connected on the RS232 or RS485 port. 
See the I106IGB1002 document on the original CD for more details about 
modem connection.

When working with modems, both the PC software and the ATS-C must be 
set to work with the Modbus® protocol. See the Configuration Options 
chapter and the setup parameters in the operating manual of the ATS-C.
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1.8 Main window

The main window displays all the various measurements returned by the 
device, providing a complete overview of the control device.

All the functions are accessible from the drop-down menus and those used 
most frequently are also shown on the toolbar. Some of these functions are 
blocked and can be accessed only after entering the user-definable password 
(after installation, the default password is EATON).

The main window contains the following displays:

• Voltage and frequency of the sources for line 1 and 2.
• Status of the switchgear
• ATS-C supply status
• Alarm status

The status bar at the bottom of the main screen shows the following 
information from left to right:

• Model and release of the internal firmware of the ATS-C connected
• Status of serial communication (ONLINE = active connection, OFFLINE 

= connection not active)
• ATS-C operating mode
• Alarm states
• Refresh rate
• Modem connection status (if used)
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Figure 4: Main window

a Switches to ONLINE mode (Communication ON)

b Switches to OFFLINE mode (Communication OFF)

c Selects operation mode on the ATS-C

d Real-time clock setting (only ATS-C144)

e Accesses the setup menu programming

f Shows a virtual front panel

g Opens Event log

h Displays statistic data

i Display of input/output status

j Switches locking of the ATS-C keypad ON/OFF

k Drop-down box to select the controller in RS485 multi-drop networks (only ATS-C 144)

l Status of AC and DC power supply

m Modem status (only ATS-C144)

n Display of refresh rate

o Current operating mode of the ATS-C

p Status of the serial connection

q ATS-C model and firmware version

r Line status indication

s Frequency reading

t Voltage readings

①② ③ ④⑤ ⑥ ⑦⑧ ⑨ ⑩ ⑪

⑫

⑬⑭⑮⑯⑰

⑳

⑲
⑱
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1.9 System configuration
The password must be entered in order to access the configuration window. 
After the first installation, the default password is EATON (the user can 
change it later). Click on the Password menu, enter EATON and then confirm 
with OK.

Now, to open the configuration window click on Configuration → Options.

The configuration phase is a very important step to correctly define the 
program operation. Particularly when several devices are connected, the user 
must ensure the correct setting of each ATS-C 114 connected to the 
network.

This section explains the settings in the configuration dialog in detail.

1.9.1 General configuration options
The General tab is used for general software settings. Note in particular the 
settings for the serial interface: enter here the PC interface used. When a PC 
is connected using the supplied USB adapter, the serial port must be defined 
and tested. The settings must match those of the ATS-C.

Figure 5: System configuration

a Software language selection 

b Settings of the PC serial interface

c Set a tick if the connection is to be made using a modem. The direct connection is implemented via the 
Modbus RTU protocol, the modem connection via Modbus ASCII.

①

②

③
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1.9.2 ATS-C144 setting options
When using a RS485 multidrop network, it is necessary to specify how many 
ATS-C 144 are connected to the PC. Enter the total number of connected 
ATS-C 144 devices and give a name to each of them.

If one ATS-C144 is not to be accessed, it is possible to disable it using the 
dedicated checkbox.

Figure 6: ATS-C144 setting options

a Enables / disables the serial communication with the selected ATS-C144

b Selected ATS-C144

c Total number of configured ATS-C144

d Adds a new ATS-C144 to the network configuration

e Removes the last ATS-C144 from the network configuration

f Select previous/next ATS-C144

g Description of the ATS-C144. It is used to identify the controller in the main page, data log, events and 
more.

1.9.3 Modem configuration options
If the software is configured for connecting via modem, it is possible to store 
a list of the various installations, i.e. a list of places where an ATS-C144 
network with modem is installed. For each installation, the user can define a 
code, a name and the corresponding phone number of the modem on the 
field. This makes it possible to connect with a particular installation by dialling 
it directly from this list. For each installation you can define the number of 
connected ATS-C144 devices and define a start page to be loaded once 
connection has been established. 

①

②

③

④ ⑤

⑥

⑦
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Figure 7: Modem configuration options

a Installation code. They must all be different. 

b Description of the installation

c Phone number of modem to be called 

d Number of ATS-C144 units connected to the modem.

e Name of page to be loaded after connection has been established. 

f To change an existing entry, select it in the table, change the values in the fields above it and then click 
Update.

g To eliminate a record, first select it in the table, then click Delete. 

h To enter a new record, first click on New, fill the fields and  then click on Add.

① ② ③

④

⑤

⑥⑦⑧
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1.10 Password

Some of the software functions are only available after a password has been 
entered (via the Password menu item). These are:

• Changing the software settings
• Changing the password
• Deleting records from data log databases
• Modifying the ATS-C settings from the remote control
• Operating the virtual front panel keys
• Resetting MAX values, event log, switch operations counter etc.

1.10.1 Password entry

Figure 8: Password

The default password after the initial installation is EATON. After the default 
password is entered, you can change it using the New password button.

1.10.2 Changing a password

Figure 9: Changing a password

1.11 Real-time clock setting (only ATS-C144)
To view and set the RTC (real time clock) of the ATS-C144, click on the 
dedicated icon on the toolbar. The following window will be shown, enabling 
you to check and modify the clock setting if necessary.

Figure 10:Setting real-time clock

a Actual ATS-C144 clock setting 

b Clicking here will transmit the current PC clock to the ATS-C144 

c Transmits the setting previously manually entered to the ATS-C144

② ③

①
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1.12 Viewing and changing device settings

Device settings are entered via a dialog field which you open via the 
Parameters menu or the button on the toolbar. If no password was entered, 
the current settings are only displayed and no changes can be transferred to 
the ATS-C.

This method of accessing ATS-C settings is easier than accessing directly via 
the front keypad since the PC displays more extensive information:

• Parameter code
• Description in the language set
• Parameter values
• Graphic box or drop-down box with possible settings
The parameters have been grouped in several menus that reflect the 
organization described in the operations manual. 

• P1 – Nominal data
• P2 – General data
• P3 – Line 1 voltage control
• P4 – Line 2 voltage control
• P5 – Programmable input
• P6 – Programmable outputs
• P7 – Serial interface ports
• P8 – Automatic test (only ATS-C144)
• A – Alarms (only ATS-C144)

You can save the complete series of settings of an ATS-C on the disk of the 
PC in an ASCII text file and transfer this to another device.

This function is useful when programming a number of ATS-C with the same 
settings or in order to maintain a master file of the original settings of a 
system. 

1.13 Online programming
If the PC is connected to an ATS-C (online), parameters are always 
transferred from or to the internal memory of the ATS-C. In this operating 
mode you can:

• View and change the parameter values. To do this choose Parameters 
menu → Edit setup parameters and then click on the Transmit or Receive 
button.

• Load a parameter file from the hard disk and transfer the settings to the 
control device (Parameters → Load file).

• Transfer settings from the control device to the PC and store them in a 
file (Parameters → Save file).

• Print out the settings of the control device (Parameters → Print).
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1.14 Offline programming

If there is no active connection to an ATS-C (offline mode), all changes are 
written to the PC hard disk. In this operating mode you can:

• Load an existing configuration file from the hard disk and view its 
content in the Setup table dialog (Parameters → Load file). You can also 
edit the settings here and store your changes in a parameter file on the 
PC (Save button) or print out the values (Print button).

• Create a new parameter file with the default settings (Parameters → 
New parameter file (default). In this case, you are asked to state the 
device type (NZM-XATS-C96 or NZM-XATS-C144) and the firmware 
version of the device (displayed on the device at startup). The latest 
version is the default value.

• Call up the Setup table dialog via the New parameter file menu. Making 
changes here without loading a file beforehand will create a new 
parameter file.

1.15 Parameter files
Each parameter file (file extension .PAR) contains the following data:

• ATS-C type and firmware version
• All parameter values
Parameters can only be written to the ATS-C if the type and firmware version 
of the parameter file match those of the ATS-C. Otherwise the program will 
report an error.
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1.16 Setup menu

Figure 11:Setup table

a Menu title 

b Slide adjuster for changing the setting value

c Parameter value; highlighted in yellow if different to the default setting. Double-clicking the field 
enables the value to be changed via the numerical keypad.

d Scrollbar

e Scroll down box with possible settings

f Closes the dialog box

g Prints out the parameter values in offline mode

h Saves the parameter values in offline line mode to a file

i Resets all values to the default settings

j Loads the parameter values from ATS-C and shows them in the dialog box. Only active in online mode.

k Transfers the displayed values to ATS-C and saves them. Only active after password entry and in 
online mode.

l Parameter description

m Code of the parameter

① ②

③

④

⑤

⑥⑦⑧⑨⑩⑪

⑫

⑬
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1.17 Modem settings (only ATS-C144)

If modems are used for connecting to the ATS-C144, the control device must 
be set for communication with the modem. These settings can only be 
carried out via the PC and not via the keypad of the ATS-C144. 

As these settings are required for the communication via modem, they must 
be made with a direct connection via the serial RS232 interface.

When a modem is used it is possible to configure the ATS-C144 so that it 
answers only calls from the PC or so that it can autonomously call the PC in 
the case of particular events (call in the event of alarms or at fixed intervals). 

ATS-C144 devices can also be connected to a GSM modem which can also 
communicate via cell phone networks. This enables communication to sites 
that are not connected to landlines. The ATS-C144 can also send SMS 
messages or emails, such as alarm states or in fixed intervals. (the sending 
of emails via SMS is not offered with cell phone networks.)

All the settings for the communication between the PC and the ATS-C144 via 
modems can be carried out in a dialog:
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1.18 View menu

1.18.1 Operating panel
The programming software also allows the front panel of the ATS-C to be 
shown on the screen of the PC. This is useful for showing the operation of 
the control device on the screen.

Call this display via View → Front panel. The display shows the device front in 
real-time, including the displays and status LEDs. 

When using several ATS-C144 devices that are interconnected via the RS485 
interface, the title bar of the window shows the name of the ATS-C144 
device displayed.

 Clicking with the mouse on the keys (after having entered the password), 
you can select the measurements and functions in the same way as on the 
physical device. However, you cannot access those functions (such as 
parameter programming, reset statistics, etc.) that require simultaneous 
pressing and/or holding down of several keys. 

The display quality depends on the resolution of the PC and screen.

Figure 12:Front view

a Name of the currently selected ATS-C. 

b Real-time display of front panel and status LEDs

c These keys can be actuated with the mouse

① ②

③

③

③

③

③③
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1.18.2 Event log
The event log contains the last 40 events with date and time. It is stored in a 
retentive memory and is thus retained in the event of a power failure.

The events recorded are:

• Source lines present / not present
• Opening/closing of switchgear
• Alarm start and end
• Operating mode change
• Parameter changes
• Data transmission on/off
• Power supply on/off

Figure 13:Ongoing event log

a Consecutive event number

b Date and time of event

c Code and description of the event

d Closes the event log window

e Prints out the event log

f Exports the event log to a text file

g Deletes all entries in the event log. Only active after password entry.

① ② ③

④⑤⑥⑦
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1.18.3 Statistics data (only ATS-C144)
The statistic data window groups some time-meters and operation counters 
that keep track of the ATS-C144 operation history. These data are stored in a 
non-volatile memory so they are not lost when the ATS-C144 is powered 
down.

Two password-protected buttons enable the user to reset timers and 
counters.

Figure 14:Statistics data

a Switch operations counters

b Time counter

c Reset buttons

①

②

③
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1.18.4 Inputs/outputs
This window shows the programmable functions of the ATS-C input and 
output terminals, and their current status. Please note that for the output 
relays, the status shown is the status of the relay coil (energized/not 
energized) that is sometimes different to the logic function of the relay 
(example: global alarm relay energized = Status ok).

Figure 15:Inputs/outputs

1.19 Keypad lock function
Using this function it is possible to lock or unlock the front panel keypad of 
the ATS-C, preventing unauthorized access to setup settings, memory 
clearing etc. see manuals:

• NZM-XATS-C96: MN01219004Z
• NZM-XATS-C144: MN01219009Z
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2 Remote control via modem (only ATS-C144)

2.1 Connection via standard modem
Two modems are required to establish a connection via a public phone 
network. Eaton guarantees correct operation of the connection using 
modems of the following type:

• 3-Com U.S. Robotics 56K model 5630

Other modems that are listed in this manual can be used (manufacturer-
specific). However, all configuration commands refer to the model stated 
above.

Modem operation is based on a simple concept. However, their 
installation requires a certain degree of specialist knowledge with 
regard to the possible problems involved with serial communication, 
data transmission, modem programming etc. To simplify the 
configuration as much as possible we have divided the procedure into 
the following steps:

1. Modem configuration at the ATS-C144 end
From the ATS-C144 end the modem must be configured before it can be 
used. Configuration serves to implement the following functions:

• Deactivate echo
• Set the transfer rate to the fixed value 9600 Bit/s
• Set these two values above as default values

To make these configurations, temporarily connect the modem to the PC via 
a standard cable. Then start the PM.EXE program supplied on the installation 
CD and click the Program modem button. Wait for the confirmation, then 
disconnect the modem from the PC and connect it to ATS-C144. The 
PM.EXE program transfers the following configuration string to the ATS-
C144.

AT E0 &N6 &U6 &W0 <CR> (for Modem Type 5630)

Users familiar with a terminal emulation program (e.g. Windows 
HyperTerminal) can also program the modem manually without using the 
PM.EXE program. In this case set the Baud rate to 9600 Bit/s, 8 data bits, no 
parity, 1 Stop bit and enter the above string. The modem then the confirms 
successfully completed programming with OK.
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2. ATS-C144 configuration
Also the ATS-C144 needs configuration to be able to converse with the 
modem. 
• Connect the ATS-C144 via a 51C2 cable (supplied with NZM-XATC-

CSOFT) to the RS232 serial interface of the PC.
• Define a password.
• From the Online mode, choose Modem parameters from the 

Parameters menu (see description on previous pages). 
• Activate the Enable modem option (Enable modem, first check box 

at top left).
• If you wish the ATS-C144 to dial the PC automatically, activate the 

Enable calls from NZM-XATS-C… and the Connect to PC check 
boxes, enter the telephone number in the phone nr. field and define 
in the CALL CONDITIONS area the events that trigger a dialup 
(￫ Section “1.17 Modem settings (only ATS-C144)”, page 18).

• Transfer and save your entries with the Transmit button.
• From the ATS-C144 front panel, enter Setup menu P7 and set the 

parameter P7.03 RS232 protocol to Modbus ASCII + modem.

3. System connection
• Connect the modem programmed at point 1 with the ATS-C144 

using the cable code 51C5.
• Connect the second modem to the PC with the standard cable 

provided with the modem. The PC-side modem does not require 
any particular programming (it must be left at default settings). 

• Connect both modems to the phone network. For the initial test, the 
use of an internal line is recommended for checking purposes.

4. Configuration of the ATS-C144 remote control program
• Start the NZM-XATS-CSOFT remote control program from the PC 

with the modem already connected and powered.
• In the Configuration menu select the Options menu item.
• Set the Connection via modem box from the General tab.
• If the Modem index table is empty, enter a name for the installation 

(ATS-C144 or ATS-C144 network) and the corresponding phone 
number of the modem connected to the ATS-C144.

• Save your entry and then close the dialog with OK.

5. Online connection
• In the Communication menu select the modem via the Modem 

menu item.
• In the list box select the installation to be called. The corresponding 

phone number (previously entered in the Modem index table) is 
displayed.

• Click Dial
• The PC modem then dials up the ATS-C144 modem. After a few 

rings, the ATS-C144 modem and the program automatically switch 
to online mode.

• To end the call, choose Hang up in the Communication menu.
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2.1.1 Troubleshooting
If during the attempted call the modem connected to the ATS-C144 does not 
‘ring’, this means that the call fails to reach its destination. In this case, carry 
out the following checks:

• Try dialing the telephone number of the modem using a normal 
telephone. The modem called should give off sounds that ought to be 
heard in the handset. If this does not happen, there are problems on the 
telephone line or on the switchboard. 

• Ensure that the modem is switched on and is connected correctly to the 
serial port defined under Communication → Serial port selection.

If the modem rings repeatedly but a connection is not established ("Modem 
connection OK" message does not appear on the screen):

• Check the ATS-C144 configuration (see previous point 2).
• Check the modem cable 51C5.

If the "Modem connection OK" message appears on the PC but the program 
switches to offline mode:

• Try connecting directly from the PC to the ATS-C144 with 51C2 cable 
and carry out all the checks described in section „RS232 direct 
connection or via USB interface“ 

• Ensure that the modem is properly set as described in Step 1 above.
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2.2 Connection via a GSM modem

To make a remote connection through the GSM cellular network a GSM 
modem needs to be connected to the ATS-C144 and a second, traditional or 
GSM modem has to be connected to the PC.

EATON guarantees correct operation of the connection using GSM modems 
of the following type:

• Falcom A-2D wireless systems

This versatile modem offers functions (SMS, email) that are not available on 
conventional modems. Although a transfer rate of 9600 Bit/s is set, the data 
transfer via a cell phone network is generally slower than via a landline.

GSM modem operation is based on a simple concept. However, their 
installation requires a certain degree of specialist knowledge with 
regard to the possible problems involved with serial communication, 
data transmission, modem programming etc. To simplify the 
configuration as much as possible we have divided the procedure into 
the following steps:

1. Configuration of the GSM modem at the ATS-C144 end
From the ATS-C144 end the modem must be configured before it can be 
used. Configuration serves to implement the following functions:

• Deactivate echo
• Set the transfer rate to the fixed value 9600 Bit/s
• Deactivate PIN request after the startup
• Enter the phone number of the SMS supplier
• Set the SMS mode to Text mode.
• Set these two values above as default values

To make these configurations the GSM modem to be connected to the ATS-
C144 should be temporarily connected to the PC with its standard cable. 
Then start the PM.EXE program (supplied together with this software) and 
press the GSM modem program button. Wait for the confirmation message 
and then disconnect the GSM modem from the PC and connect it to the 
ATS-C144. 

Important:

The GSM modem requires a data-enabled SIM card. A normal SIM card 
for cell phones is not suitable. To activate a SIM card for data transfer 
contact your cell phone network supplier. If your SIM card has different 
phone numbers for voice and data transfer, use the number for data 
transfer.

2. ATS-C144 configuration
Also the ATS-C144 needs a configuration to be able to converse with the 
modem. 

• Connect the ATS-C144 to the RS232 serial interface of the PC via a 
cable. 

• Check that the software revision in the ATS-C144 is 11 or higher.
• Define a password.
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• From the Online mode, choose Modem parameters from the 
Parameters menu (see description on previous pages). 

• Activate the Enable modem option.
• Activate the GSM modem check box.
• If you wish the ATS-C144 to dial the PC automatically, activate the 

Enable calls from NZM-XATS-C… and the Connect to PC check 
boxes, enter the telephone number in the phone nr. field and define 
in the CALL CONDITIONS area the events that trigger a dialup 
(￫ Section “1.17 Modem settings (only ATS-C144)”, page 18).

• If you want the ATS-C to send an SMS message in the event of the 
above-mentioned conditions, activate one or more Send SMS 
options and specify the number of the cell phone to which the SMS 
is to be sent for each one of them.

• In the same way, if you want the ATS-C144 to send an electronic 
mail message, activate the Send E-mail option and specify the 
electronic mail address of the addressee in the special box.

• Transfer your entries with the Transmit button.
• From the ATS-C144 front panel, enter Setup menu P7 and set the 

parameter P7.03 to “Modbus ASCII + modem“.

3. System connection
• Connect the GSM modem programmed at point 1 with the ATS-

C144 via cable code 51C7.
• Connect the second modem to the PC with the standard cable 

provided with the modem.
• Switch on the GSM modem and wait 30 seconds until the modem is 

initialized.
4. Configuration of the ATS-C144 remote control program

• Start the ATS-C144 remote control program from the PC with the 
modem already connected and powered.

• In the Configuration menu select the Options menu item.
• Set the Connection via modem box from the General tab.
• If the Modem index table is empty, enter a name for the installation 

(ATS-C144 or ATS-C144 network) and the corresponding phone 
number of the modem connected to the ATS-C144.

• Save your entry and then close the dialog with OK.

5. Online connection
• In the Communication menu choose the Modem menu item.
• In the list box select the installation to be called. The corresponding 

phone number (previously entered in the Modem index table) is 
displayed.

• Click Dial
• The PC modem then dials up the ATS-C144 modem. After a few 

rings, the ATS-C144 modem and the program automatically switch 
to online mode.

• To end the call, choose Hang up in the Communication menu.
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2.2.1 Troubleshooting
If during the attempted call the GSM modem connected to the ATS-C144 
does not ‘ring’, this means that the call fails to reach its destination. In this 
case, carry out the following checks:

• Check whether the signal at the location of the GSM modem is strong 
enough (> 40 %). To do this use the PM.EXE program.

• Ensure that the modem is switched on and is connected correctly to the 
serial port defined under Configuration → Options → Serial port settings.

If the modem rings repeatedly but a connection is not established (the 
"Modem connection OK" message does not appear on the screen):

• Check the ATS-C144 configuration (see previous point 2).
• Check the ATS-C144-modem cable 51C7. 
• If the telephone connection is provided via an exchange, try to use a 

direct connection. Some connections change the call so that it is not 
recognizable for the GSM.

If the "Modem connection OK" message appears on the PC but the program 
switches to offline mode:

• Check the quality of the GSM signal.
• Try connecting directly from the PC to the ATS-C144 with cable 51C2 

and carry out all the checks described in section „RS232 direct 
connection or via USB interface“.

• Ensure that the GSM modem is properly set as described in Step 1 
above.
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3 Commands via SMS message (only ATS-C144)

When using a GSM modem, the ATS-C144 can be controlled by any cell 
phone using SMS. For this an SMS with the required commands is sent to 
the GSM modem connected to the ATS-C144. The command syntax is very 
simple and largely complies with the markings on the front of the ATS-C144. 
The MAN command, for example, is the same as pressing the MAN button 
on the ATS-C144. In this way it is possible to operate the ATS-C144 from any 
location.

To prevent unauthorized access, the commands must be preceded by a 
password defined by the user during installation. If the SMS message is not 
preceded by the correct password, it will be ignored. If however the 
message comes from one of the cell phones defined as addressees of alarm 
messages (see modem parameters window), the password will not be 
necessary.

The following table lists the commands available:

Several pause-separated commands can be entered in succession.

To execute commands via SMS, activate the Enable SMS commands check 
box in the Modem parameters dialog (￫ Section “1.17 Modem settings 
(only ATS-C144)”, page 18). In the SMS commands password field define a 
password if necessary. As already mentioned, password entry is not required 
before sending a command, if the command is sent from a cell phone that is 
defined as a receiver of SMS alarm messages. In this case, the phone 
number (under Send SMS) must be entered in the international format, e.g. 
+49228123456.

After performing a sequence of commands the ATS-C144 will answer with a 
confirmation message that will be sent to the cell phone that generated the 
message.

Command Function

RESET Switches to RESET-OFF mode and resets alarms

MAN Switches to MAN (manual) mode

AUT Switches to AUT (automatic) mode

TEST Switches to TEST mode

ONOFF1 Simulates the actuation of the ON-OFF LINE 1 button

ONOFF2 Simulates the actuation of the ON-OFF LINE 2) button

PWD=<password> Entry of the access password
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The confirmation message has the following structure:

• ATS-C144-Identification
• Operating mode
• Status line 1
• Status line 2
• Status switchgear 1
• Status switchgear 2

If the password in the SMS message does not correspond with the one 
stored in the ATS-C144, the commands will not be performed and an 
appropriate message will be sent.

The criteria and structure of the SMS command function are identical to the 
Autocall function. The two functions can also be used simultaneously. For 
further information on its use and troubleshooting, (￫ Section “1.17 
Modem settings (only ATS-C144)”, page 18).
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